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Preface 

 

The National Curriculum Framework, 2005, recommends that children‟s life at 
school must be linked to their life outside the school. This principle makes a 

departure from the legacy of bookish learning which continues to shape our 

system and causes a gap between the school, home, community and the 

workplace.  

The student workbook on “Word Processing (Basic)” is a part of the 
qualification package developed for the implementation of National Vocational 

Education Qualification Framework (NVEQF), an initiative of Ministry of Human 

Resource Development (MHRD), Government of India to set common principles 

and guidelines for a nationally recognized qualification system covering 

Schools, Vocational Education and Training Institutions, Technical Education 

Institutions, Colleges and Universities. It is envisaged that the NVEQF will 

promote transparency of qualifications, cross-sectoral learning, student-

centred learning and facilitate learner‟s mobility between different 
qualifications, thus encouraging lifelong learning.  

This student workbook, which forms a part of vocational qualification package 

for student‟s who have passed Class VIII or equivalent examination, was created 
by a group of experts. The IT-ITeS Skill Development Council approved by the 

National Skill Development Corporation (NSDC) for the IT/ITeS Industry 

developed the National Occupation Standards (NOS). The National Occupation 

Standards are a set of competency standards and guidelines endorsed by the 

representatives of IT Industry for recognizing and assessing skills and knowledge 

needed to perform effectively in the workplace.  

The Pandit Sunderlal Sharma Central Institute of Vocational Education 

(PSSCIVE), a constituent of National Council of Educational Research and 

Training (NCERT) in association with Wadhwani Foundation has developed 

modular curricula and learning materials (Units) for the vocational qualification 

package in IT/ITes sector for NVEQ levels 1 to 4; level 1 is equivalent to Class 

IX. Based on NOS, occupation related core competencies (knowledge, skills, and 

abilities) were identified for development of curricula and learning modules 

(Units).  

This student workbook attempts to discourage rote learning and to bring about 

necessary flexibility in offering of courses, necessary for breaking the sharp 

boundaries between different subject areas. The workbook attempts to 

enhance these endeavour by giving higher priority and space to opportunities 

for contemplation and wondering, discussion in small groups and activities 

requiring hands-on-experience. We hope these measures will take us 
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significantly further in the direction of a child-centred system of education 

outlined in the National Policy of Education (1986). The success of this effort 

depends on the steps that school Principals and Teachers will take to encourage 

children to reflect their own learning and to pursue imaginative and on-the-job 

activities and questions. Participation of learners in skill development exercises 

and inculcation of values and creativity is possible if we involve children as 

participants in learning, and not as receiver of information. These aims imply 

considerable change in school routines and mode of functioning. Flexibility in 

the daily time-table would be a necessity to maintain the rigour in 

implementing the activities and the required number of teaching days will have 

to be increased for teaching and training.  
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About Your Workbook 

This workbook is to assist you with completing the Unit of Competency IT104-
NQ2012: Word Processing (Basic). You should work through the workbook in 
the classroom, at the workplace or in your own time under the guidance and 
supervision of your teacher or trainer. 

This workbook contains sessions which will help you to acquire relevant 
knowledge and skills (soft and hard) on various aspects of the unit of 
competency.  Each session is small enough to be easily tackled and digested by 
you before you move on to the next session. Animated pictures and 
photographs have been included to bring about visual appeal and to make the 
text lively and interactive for you. You can also try to create your own 
illustrations using your imagination or taking the help of your teacher. Let us 
now see what the sections in the sessions have for you. 

Section1: Introduction 

This section introduces you to the topic of the Unit. It also tells you what you 
will learn through the various sessions covered in the Unit.  

Section 2: Relevant Knowledge 

This section provides you with the relevant information on the topic (s) covered 
in the session. The knowledge developed through this section will enable you to 
perform certain activities. You should read through the information to develop 
an understanding on the various aspects of the topic before you complete the 
exercise (s). 

Section 3: Exercise 

Each session has exercises, which you should complete on time. You will 
perform the activities in the classroom, at home or at the workplace. The 
activities included in this section will help you to develop necessary knowledge, 
skills and attitude that you need for becoming competent in performing the 
tasks at workplace. The activities should be done under the supervision of your 
teacher or trainer who will guide you in completing the tasks and also provide 
feedback to you for improving your performance. To achieve this, prepare a 
timetable in consultation with your teacher or trainer and strictly adhere to the 
stipulated norms or standards. Do not hesitate to ask your teacher or trainer to 
explain anything that you do not understand. 

Section 4: Assessment 

The review questions included in this section will help you to check your 
progress. You must be able to answer all the questions before you proceed to 
the next session.   

At the end of the Unit, there is a list of learning resources which include books, 

journals, newsletters, websites, etc. to support your further learning.   
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SESSION 1: GETTING STARTED WITH A WORD PROCESSOR 

Word processors help us deal effectively with most of such issues. Let us 

understand how word processors have an edge over using the traditional paper 

and pen. Using word processors, you can create and use a Word document. 

Word processors provide flexibility, ease, neatness and speed. You can use it 

for writing documents such as, articles, letter, resume, report, poem and also 

making posters. To sum up, a word processor can help you to: 

 Correct any spelling mistakes made and also prompt you when you make 

spelling error. 

 Insert or overwrite a word or sentence or paragraph, anywhere in the 

word document. This helps to maintain the neatness of the document. 

This task is called editing the document. 

 Print a document created by you and also store it for future use, without 

a worry of it getting misplaced/ fading. You can also print multiple 

copies of the document in a single command. 

 Change the appearance of different portions of a document, by changing 

the size of the words, make them bold or italic or underlined etc. 

 Insert, headers and footers and page numbers (which increment 

automatically, if you so desire!). 

 Present information in a tabular form as a part of the document. 

 Insert pictures, and images into the document. 

RELEVANT KNOWLEDGE 

Some of the most popular Word Processing software are: 

 OpenOffice – Write (desk top based) 

 MS-Word (desk top based) 

 Google Documents(Internet based) 

 Notepad(limited features) 

Though you can choose any of the above listed software to start creating 

documents, it is preferable that you start learning word processing by using 

either the OpenOffice–Write or MS-Word. Make sure that this software is 

already installed in your computer. You can start using MS-Word software, by 

performing any one of the following steps: 

a) Double Click on a shortcut key of the MS-Word  icon, if available, on the 

desktop; OR 

b) Click [1] Start  [2] All Programs  [3] Microsoft office [4] Microsoft 

Office Word 
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If you are using any other word processor, the steps to start that word 
processor would be almost identical to what is given above. 

Once you start MS-Word, the following screen (Figure 1) is displayed. The 
components of the screen displayed are as shown in Figure 1. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Opening or Creating a Document 

To begin with, let us create a simple document. Before creating the document, 

create a folder “D:\IT Class IX\WP_Practice” where you shall store all the 

documents that you create. 

Open: Start the word processor as learnt in the exercise 1. Write the following 

paragraph in the work area of your screen. 

 

 

 

 

Listening is an art. God gave us two ears and one mouth, so that we speak 

less and listen more. Only by listening carefully can we understand what the 

other person is saying and the meaning behind the words being spoken. This 

helps us understand the facts and opinions of the other person. This also 

helps us to improve the quality of the questions we can ask the other 

person.  

Office 
Button 

Quick Access 
Toolbar 

Title Bar 

Ribbon 

Work Area 

Figure 1: MS-Word 
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Saving a Document 

Save: Till now this paragraph that you have written is present in the internal 

memory of the computer, which is also called RAM (Random Access Memory). 

You need to save this document as a file on the hard disk of your computer. 

You can do so by doing the following steps: 

o In the Quick Access bar, click the symbol for the floppy  

 

OR 

1. Click the [1] File  [2] Save. 

2. A Save As dialog box appears.  

3. Choose the Directory (Drive and Folder) by clicking on the one 

that you want in the list shown on the left hand side. You will see 

the path on the D:\IT Class IX\WP_Practice displayed as you select 

the path. 

4. Enter the name which you would like to give to this document in 

the File name box. For example, you can give the name Listening 

to this file. 

5. Click Save. 

Now this word document would be saved in MS-Word with the name 

Listening.docx, in the directory specified by you. The first part of the filename- 

Listening-is the name you gave to this file and .docx is the extension name for 

any document created under MS-Word.  

Closing a Document 

Close: You can close this document by following one of the following steps: 

o Click on the cross symbol “X”, that you see on the top right hand corner 

of the screen. 

OR 

o Click the [1] File [2] Close. 

 

EXERCISE 

 

Perform the following activities till you are confident: 

S.No. Activity 

1.  Start a word processor 

2.  Identify various toolbars 

3.  Create a new document 

4.  Save  and close a document 
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SESSION 2: EDIT AND SAVE A DOCUMENT 

What happens if you want to take an existing document and want to add a 

paragraph or some words in it or edit it? Here in this exercise you from where 

you left it in the previous exercise. In this exercise, you will be opening the file 

saved in exercise 2 (D:\IT Class IX\WP_Practice \Listening.docx), editing it and 

then saving it under a different file name.  

RELEVANT KNOWLEDGE 

To begin, start the word processor. 

a) Open: You can open a document only if it had been created earlier and 

saved on the hard disk / any other storage device. In the previous exercise, 

you had created a document and saved it with the name Listening.docx. To 

open this word document: 

 

o Click the [1] File  [2] Open. An Open dialog box appears. 

o Select the drive and folder, select filename and click the Open button. 

The saved document opens. 

 

b) Edit: After you open Listening.docx you can make changes to it, by adding 

another paragraph, or modifying any words or sentences which you had 

already written. Add one more paragraph in this document on” The Art of 

Listening”. You can add material on your own or use the follow paragraph: 

 

 

 

 

 

 

 

 

 

c) Save As: Do remember that having made further changes; you need to save 

the changes by saving this modified document once again. You can save it 

with the same name Listening.docx, in which case the older file saved 

earlier will get overwritten by the changes which you made. Alternatively, 

you may like to keep the earlier file Listening.docx as it is, and save the 

modified document using a new file name, e.g. Listening2.docx. 

 

 To save it with a different name, use the following steps: 

o Click the [1] File  [2] Save As 

When we listen to another person, do not start judging what the other 

person is saying. Just listen and seek to understand the other person. This 

will help us to listen and seek to understand the point of view of the other 

person, without trying to judge whether you agree / disagree with what 

the other person is saying. By doing this you will become a more effective 

listener. 
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o A Save As dialog box appears. Choose the Directory (Drive and 

Folder) by clicking on the one that you want in the list shown 

on the left hand side. You will see the path on the D:\IT Class 

IX\WP_Practice displayed as you select the path.  

o Enter the file name which you would like to give to this 

document. For example, you may give the name Listening2, to 

this file. 

o Click Save 

 

d) To practice once again what you have learnt, repeat the above three steps 

by  opening any other existing document in your computer, making changes 

to the contents of that file and saving this file with another name. 

 

EXERCISE 

 

Perform the following activities till you are confident: 

S.No. Activity 

1.  Open a document from the specified location 

2.  Type text and make insertions in an existing document 

3.  Save an existing document with a new file name 

 

Additional Practice Exercises: 

1. Open a new document and write one paragraph about your favourite leader. 

Save the document with the name of the leader. 

2. Pick up one paragraph from an English newspaper or magazine or your 

English text book and write that paragraph and save it as a file, with an 

appropriate name. 
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SESSION 3: IDENTIFY ELEMENTS OF USER INTERFACE 

By now you would have observed that word processing software has very simple 

interface using menus in the Ribbon. Most of the commonly used functions have 

a graphical symbol or icon in the Ribbon. This kind of user interface is called 

Graphical User Interface or GUI (commonly pronounced ’gooey’). GUI is a type 

of user interface that allows users to interact with electronic devices using 

images rather than text commands. This section will familiarize you with the 

elements of the user interface. 

RELEVANT KNOWLEDGE 

In this session, you will take a short tour of the different tabs and some of the 

options under this tab, in the presentation software.  

 

 

 

 

 

 

As shown in Figure 2 the Ribbon has eight Tabs; namely, File, Home, Insert, 

Page Layout, References, Mailings, Review, and View. Each tab further consists 

of the groups, and the groups contain icons. Icons are a pictorial representation 

for a command. Each Tab is self-explanatory; for example, if you want to insert 

any item into the document, click on the Insert tab. The groups and icons 

related to Home tab are displayed. Select the icon for the command which you 

want to use. The different tabs in MS-Word and the groups within them are as 

follows -   

1. Home: Clipboard, Font, Paragraph, Styles, Editing 

2. Insert: Pages, Tables, Illustrations, Links, Header & Footer, Text 

3. Page Layout: Themes, Page Setup, Page Background, Paragraph, Arrange 

4. References: Table of Contents, Footnotes, Citations & Bibliography, 

Captions, Index, Table of Authorities 

5. Mailings: Create, Start Mail Merge, Write & Insert Fields, Preview Results, 

Finish 

Tabs 

Icons Groups 

Figure 2: User Interface 

http://en.wikipedia.org/wiki/User_interface
http://en.wikipedia.org/wiki/User_(computing)
http://en.wikipedia.org/wiki/Human-computer_interaction
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6. Review: Proofing, Comments, Tracking, Changes, Compare, Protect 

7. View: Document Views, Show/Hide, Zoom, Window, Macros. 

 

 Each Tab consists of different groups, like the Home tab has five groups 

namely, Clipboard, Font, Paragraph, Styles and Editing.  

 Each group has icons for the related commands, for example, the Font group 

in the Home tab has all font related icons in it. To know the function of an 

icon, or button (or command), leave the pointer on a button for a few 

seconds, the function of that button appears in a small box below the 

pointer. For example, leaving the icon on  displays “Bold (Ctrl+B)”. 

Home Tab: 

Let‟s understand the Home tab in more detail. The Home tab contains 

commands for formatting of text, selecting a new slide and drawing of objects. 

The Home tab is also used for editing content of documents (find and replace, 

and to perform clipboard operations such as cut, copy and paste. You will learn 

about these functions later in the course). 

 The Clipboard group contains commands to cut, copy and paste text. The 

Format Painter is also present here.  

 Font group commands allows change of the Font – font face, style, size, 

effects (Strikethrough, Shadow etc.), color and character spacing. These 

options can be changed, before or after typing the text. If case of after, 

select the text first.   

 Paragraph group is used to change paragraph settings – alignment, indents, 

spacing, and pagination like Spacing 1.5, Double Spacing, Indentation, 

Spacing Before and After a Heading. Move the cursor to the line which needs 

to be changed.    

 The Styles group allows quickly choosing a style and applying the style.     

 Editing group contains commands to select, find and replace text.     

 

 

 

 

 

 

 

http://in.wrs.yahoo.com/_ylt=A0WTf2j7irhJXnIBxEG9HAx.;_ylu=X3oDMTBqdGFzdWxiBHBvcwMxNQRzZWMDc3IEdnRpZAM-/SIG=1fjeb35tb/EXP=1236917371/**http:/in.images.search.yahoo.com/images/view?back=http://in.images.search.yahoo.com/search/images?fr=yfp-t-in&type=ds&p=bold+icon&w=20&h=20&imgurl=www.panerai.com/img/editor_html/icon_bold.gif&rurl=http://www.panerai.com/img/editor_html&size=79B&name=icon_bold.gif&p=bold+icon&type=gif&oid=636f2682174c8336&no=15&tt=3,888&sigr=11645kcf4&sigi=11ddunsdt&sigb=12fevjgea
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In more detailed description of the different options available under each of 

the groups is given in the table below.  

Home Tab 

Groups 

Description 

Clipboard 

 Paste the cut or copied information in Clipboard at the 

location where cursor is pointing right now (Paste 

Special - To paste in a particular format. Paste as 

Hyperlink - Used with copy to paste the copied 

information as a hyperlink) 

 Cut the selected text from the document and put into 

Clipboard for later retrieval. 

 Copy the selected item or text to the Clipboard. 

 Format painter copies formatting from one place and 

apply to another (To apply same formatting to many 

places, double-click the format painter button) 

Font 

 Change Font face, change font size 

 Grow Font, Shrink Font 

 Clear formatting (Clear all formatting from selection, 

leave only plain text)  

 Bold, Italics, Underline 

 Strikethrough (draw a line through middle of selected 

text), Subscript, Superscript 

 Change case. You can change the case – sentence, 

lower, upper, title, or toggle. Select the text and click 

on an option 

 Font color, Text highlight color 

Paragraph 

 Bullets (choose from different styles) 

 Numbered list(choose different formats) 

 Multilevel list (Choose from different styles) 

 Increase or decrease indent of the paragraph 

 Sort alphabetically or numerically 

 Show paragraph markups 

 Align text left, right, centre, margins 

 Change spacing between lines 

 Color background behind selected text 

 Customize the borders of selected text. Add borders 

and shading. There are options to select for setting, 

style, color, width, fill color, and pattern. You will see 

a preview at the right. To remove a border or shading, 

select None.  
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Styles 

 Format titles using different styles like Caption, 

Emphasis etc. 

 Change style, color and font used in the document 

Editing 

 Find text in the document 

 Replace text in the document ( The user can go to a 

page, section etc. when using find and replace) 

 Select text or objects in the document 

 

EXERCISE 

 

Perform the following activities till you are confident: 

 

S.No. Activity 

1.  Identify and describe the purpose of different Tabs - File, Home, 

Insert, Page Layout, References, Mailings, Review, and View. 

2.  Identify and describe the purpose of Home Tab Groups - Clipboard, 

Font, Paragraph, Styles and Editing 
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SESSION 4: FORMAT A DOCUMENT – BOLD, ITALICS AND UNDERLINE 

When you create a document, you may want some words/phrases/sections to 

immediately catch the reader‟s eye.  As a student you have done that by 

underlining text in your textbooks.  

RELEVANT KNOWLEDGE 

A word processor enables you to select and make parts of the documents bold 

or italics or underlined. 

a) Open a new document in  word processor and type in the following 

paragraph: 

 

 

 

 

 

 

Now to make this paragraph to look better, you may need to format it like 

the paragraph shown below. You will notice that some words of this 

paragraph are in bold, some are in Italics and some are underlined. 

 

 

 

 

 

 

b) Selecting a text: Before you can make “What is A Team?” bold, you need to 

select this text. Use the following steps to do so: 

What is A Team? 
“A team is a number of persons associated together in work or activity: as a 
group on one side (as in football or debate).”  A Team is a group of people 
working together „or‟ come together as a team to achieve a common shared 
goal. In other words, when one person cannot complete a job alone and several 
individuals must cooperate to fulfill a mission, you need a team. The better the 
cooperation, communication, and coordination among team members, the more 
efficient the team. 
 
“Individually, we are one drop. Together, we are an ocean.” 

What is A Team? 
“A team is a number of persons associated together in work or activity: as a 
group on one side (as in football or debate).”  A Team is a group of people 
working together „or‟ come together as a team to achieve a common shared 
goal. In other words, when one person cannot complete a job alone and several 
individuals must cooperate to fulfill a mission, you need a team. The better the 
cooperation, communication, and coordination among team members, the 
more efficient the team. 
 
“Individually, we are one drop. Together, we are an ocean.” 
 

http://thinkexist.com/quotation/individually-we-are-one-drop-together-we-are-an/391196.html
http://thinkexist.com/quotation/individually-we-are-one-drop-together-we-are-an/391196.html
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 Move your cursor , so that it is on or just before the capital W at the 

beginning of “What”. 
 Press and hold down the left button of your mouse, then drag the 

cursor , to the right, going over the words “What is a Team?”, and 

then release the left mouse button.     

 What is a Team? will appear. The shaded background and highlighted 

letters indicates that these words have been selected.   

 

Note: To select just a single word, you need to double click on it.  

Bold: A band on top has been marked as Ribbon. Towards the left side of the 

Ribbon, on the Home tab, you will see B I U  (Figure 3). Click on the Alphabet B 

in the Font group, and you will see that the words “What is A Team?” is now 

bold. Go ahead use the same steps and make the required words bold. 

Underline: The steps for underlining, any word or a group of words is exactly 

the same as foe Bold, except that after selecting the text, instead of clicking B, 

you need to click U in the Font group. 

Italics: The steps for italicising, any word or a group of words is exactly the 

same as the above two, except that after selecting the text, you need to click I 

in the Font group. 

 

 

 

You may like to enter some more text from your English text book and practice 

making words Bold, Italics or underlined. 

EXERCISE 

 

Perform the following activities till you are confident: 

S.No. Activity 

1. Mark text as Bold 

2. Underline the text 

3. Convert text to Italics 

 

 

 

Figure 3: Font Group 
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Additional Practice Exercises: 

1. Write a paragraph about the sports activities in your school. Give a heading 

to this paragraph. Bold and Underline the heading. Save this document in 

your computer. 

2. Write a Notice for your notice board saying you have lost your English 

Textbook. Give it a heading “Lost English Textbook”. Underline the name 

of the textbook in the main body of the notice. 

 

  



20 

 

SESSION 5: CHECK SPELLING 

RELEVANT KNOWLEDGE 

The word processor also helps us create flawless documents by checking the 

spellings. In case we have typed wrong spellings, the processor can highlight 

the words that have been spelt wrongly. 

a) Open a new document in word processor and type in the following 

paragraph. You would notice that some words given in this paragraph have 

spelling mistakes. Type the paragraph along with these mistakes. 

 

 

 

 

 

 

b) You would notice that the words which have spelling mistakes are 

highlighted with a wavy red line (for example: hwo). This is done 

automatically by the word processor. 

1. Click on the Review tab on the Ribbon.  

2. Click on the option Spelling & Grammar in the Proofing group, as shown in 

Figure 4. 

 

 

 

 

 

3. The Spelling and Grammar dialog box appears. You can see that it is 

suggesting that the correct spelling is “how”. You can click on the 

suggestion “how” and the spellings will be automatically corrected and 

the dialog box will proceed to show you the next spelling mistake and 

We spend years learning hwo to read and write but not even a class or 

two on listening! People think that listening is nattural and that they do 

not have to learn it. It‟s like breathing. 

This is sad since listening is primarily responsible for the many problims 

we have with each other. We speak at an average of 150 words per 

minute but our mind with its billions of cells can process almost a 

thoujand words per minute. Managing this excess brain capicity is the 

clue to effective listening. 

Review Spelling & Grammar 

Figure 4: Review Tab Options 
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give you multiple options through the dialog box. You can choose the 

applicable suggestion or option and move ahead. 

 

Note: Though the word processor may suggest changes, you need to use your 

own discretion whether to change / not to change the spelling; or, which 

spelling to choose from the list provided. Also, the word processor 

automatically runs through your entire document suggesting corrections for 

spelling and grammar. If you have selected some text, it will first check the 

selected text and then prompt you for checking the rest of the document. 

A word processor also provides another way to change a spelling mistake. The 

steps are listed below: 

3. Position the cursor on any part of the misspelt word (the word with a wavy 

red line below it).  

4. Right-click the mouse. 

5. A pop-up menu box appears (Figure 5). 

6. You can select the correct spelling option on the top (given as “natural”) 
and the spelling will be corrected automatically in the text. 

Go ahead and correct the spelling mistakes in the paragraph (Figure 6). 

 

 

 

 

 

 

 

 

 

 

 

 

 Figure 6: Spelling and Grammar dialog box 

Figure 5: Pop-up menu box (Spelling) 
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EXERCISE 

 

Perform the following activities till you are confident: 

 

S.No. Activity 

1. Identify spelling errors in a document 

2. Run spell check for correcting spelling errors in a document 

3. Add words to the dictionary of the word processor 
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SESSION 6: CHECKING GRAMMAR AND USING THESAURUS 

As you create a document, you sometimes make grammatical mistakes or are 

looking for a different word to explain what we mean. Word processors help us 

in these corrections. 

RELEVANT KNOWLEDGE 

Check Grammar 

The word processor can also check and point out grammatical mistakes in the 

sentences we have typed. 

a) Open a new document in word processor and type in the following 

paragraph. You would notice that each of these sentences have some 

grammatical mistakes. Type the paragraph along with these mistakes. 

 

 

 

b)  You will notice that the spelling mistakes are automatically underlined by 

red color and grammatical mistakes by a wavy green line. 

c) The method of correcting grammatical mistakes is exactly the same as that 

for correcting the spelling mistakes.  

1. Click on the Review tab on the Ribbon.  

2. Click on the option Spelling & Grammar in the Proofing group 

The Spelling and Grammar dialog box appears. It will prompt you with 

suggestions. You can select the suggestion and the text will be 

automatically corrected and the dialog box will proceed to show you the 

next error with suggested changes. You can choose the applicable 

suggestion or ignore it and move ahead. 

Note: Though the word processor may suggest changes, you need to use 

your own discretion whether to change / not to change the text 

A word processor also provides another way to change a grammatical 

mistake. The steps are listed below: 

1. Position the cursor on any part of the word with a wavy green line below 

it.  

I will went to the market tomorrow. 

She will be very sad to left us. 

She finish making breakfast. 
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2. Right-click the mouse. 

3. A pop-up menu box appears (Figure 7). 

 

 

 

 

 

 

 

4. On the menu, you may be given a suggested correction. You can choose 

to ignore the error or click About This Sentence to see why the processor 

considers the text to be a mistake. 

 

So go ahead and correct the above grammatical mistakes. 

Practice more by writing text with spelling and grammatical errors and then 

correct them. 

Using Thesaurus 

Sometimes while creating a document, you search for a word similar in meaning 

to the word you have in mind. A word processor helps you to look up synonyms 

(different words with the same meaning) and antonyms (words with the 

opposite meaning) in the thesaurus  

How is it different from a dictionary? A dictionary contains definitions and 

pronunciations, whereas thesaurus will have words with similar meanings or 

opposite meanings. 

Let‟s check the thesaurus for words which have similar meanings to market. 

Figure 7: Pop-Up menu box (Grammar) 

http://en.wikipedia.org/wiki/Dictionary
http://en.wikipedia.org/wiki/Definitions
http://en.wikipedia.org/wiki/Pronunciations
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 Select the text “market’. 
 Click on the Review tab. You will see the various options as listed in the 

Proofing group.  

 Position the cursor anywhere on the word „market’ and click the Thesaurus 

option. A box opens up on the right side of the screen. This is the Research 

task pane where the result of your search is displayed.  In this pane, you will 

see a list of words similar to the one you had selected. The selected word is 

displayed in the small box at the very top of this pane and possible 

replacements are displayed in the longer list. 

You can see that some of the similar words are: marketplace, souk, bazaar, 

shop, arcade, fair etc. 

 To use one of the words in the list of results or to search for more words, do 

one of the following:  

o To use one of the words in the list, place your cursor on it, click 

the down arrow that appears on doing so, and then click on one of 

the three options.  

 To replace the word in your document, click on Insert.  

 Click on Copy to copy the word, but not replace anything in 

your document. You can paste the copied word in your 

document, using the Home tab Paste option. 

 Click on Look Up to see other possible replacement words. 

Note: If you click on the listed word instead of the down arrow, 

you will replace the word in the small box at the very top of the 

research pane 

o To look up additional related words, click a word in the list. 

Practice more by entering the words like school, cinema, communication, etc.  

 

 

 

 

 

 

 

 

Figure 8: Thesaurus 

Figure 9: Thesaurus 
Options 
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EXERCISE 

 

Perform the following activities till you are confident: 

 

S.No. Activity 

1. Identify grammatical errors in a document 

2. Run spelling and grammar check for correcting grammatical errors in 

a document 

3. Run Thesaurus for inserting synonyms in the document 
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SESSION 7: COPY - PASTE AND CUT - PASTE 

RELEVANT KNOWLEDGE 

In a handwritten document to repeat a paragraph, or, if a paragraph was to be 

moved elsewhere, you would need to write the whole document all over again! 

However, using word processor, this can easily be done using the Copy/Cut and 

Paste feature. 

Copy and Paste 

You can copy text from the document to a different position in the same 

document or to a new document. The original text is not altered. Enter the 

following text in a new document. 

 

 

 

 

 

 

To copy the first point “Not interrupting others while they are talking;” and 

paste it at the end of the last line, follow the steps given below: 

Note: 

Copy means to Select text and then Copy that text onto your “clipboard”.  The 

“clipboard” is a temporary short-term data storage area in your computer 

where the text is temporarily placed. 

Paste means to place the text that is on the “clipboard” into your document. 

1. Select the text that is to be copied.  

2. Right-click the mouse anywhere on the selected text. A pop-up menu 

appears (Figure 10). 

3. Click Copy. The menu goes away. 

4. Click at the end of the last line in the document and press Enter. The 

cursor moves down to the next line. 

5. Right-click, then click Paste. The selected sentence is copied below the 

Some good manners to keep in mind are: 
 

- Not interrupting others while they are talking; 
- Not carrying on side conversations while someone is talking; 
- Considering other‟s feelings and concerns when making decisions 

or comments; 
- Being respectful of the instructor and classmates; your peers 

and superiors at the workplace,` 
- Avoiding arguments and disagreements; 
- Providing assistance when asked; 
- Using terms such as “please” and “thank you.” 
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last sentence.  

Notice that the original sentence is still at the same place, it has been 

duplicated at the end of the last sentence. 

Cut and Paste 

There is a minor but very important difference between “Copy and Paste” and 

“Cut and Paste.” 

 In “Copy and Paste” the original set of text remains where it was and it 

is also pasted to another place in the document. 

 In “Cut and Paste” the original set of text gets deleted and it pasted to 

another place in the document. 

You can now try the “Cut and Paste” feature by cutting the line “Avoiding 

arguments and disagreements”, and pasting it as the first line of your 

document. To do so, use the following steps: 

Note: 

1. Cut means to Select text and then 

Copy that text onto your “clipboard”.  

2. Select the text that is to be copied. 

(You have learnt to select text in 

Exercise 4.) 

3. Right-click the mouse anywhere on the 

selected text. A pop-up menu appears. 

Click Cut. The menu goes away. 

4. Click at the beginning of the first line 

in the document and press Enter. 

5. Right-click, then click Paste. The 

selected sentence is copied below the 

last sentence. 

Notice that the original sentence has been deleted. 

 

EXERCISE 

 

Perform the following activities till you are confident: 

 

S.No. Activity 

1. Select, copy and paste text in a document 

2. Select, cut and paste text in a document 

Figure10: Pop-up Menu (Cut / Copy / 
Paste) 
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SESSION 8: FIND AND REPLACE TEXT 

RELEVANT KNOWLEDGE 

The documents that we create in a word processor are not always small 

paragraphs of a few sentences. Mostly these documents are multi-page. Study 

notes are a good example of such documents. Suppose you have created Social 

Science notes using word processor. You notice that at some places in the 

document the word Delhi has been misspelled as Dlehi. Now to correct it you 

have to go each specific location in the document where correction is to be 

made. You can use the Find and Replace feature of word processor to easily do 

this task. Using this feature, you can find all the occurrences of a specific word 

or group of words in a document and also replace them with a new word or a 

group of words. 

Enter the following text in a new document and save the file with the name 

Global Warning. 

 

 

 

 

 

In the above text you would notice that four words have been highlighted. You 

have entered the word “Warning” instead of “Warming.” You will now learn 

how to find the “warning” at each of the places it occurs in the document and 

replace the word with “warming”. Follow the steps given below: 

 Click Find in the Home tab, Editing group or press CTRL+F keys together.  

 

 

Figure 11: Find in Home Tab 

What is Global Warning?  

Global warning is when the earth heats up (the temperature rises).  Global 
warning happens when greenhouse gases (carbon dioxide, water vapor, 
nitrous oxide, and methane) trap heat and light from the sun in the earth‟s 
atmosphere, which increases the temperature.  This hurts many people, 
animals, and plants.  Many cannot take the change, so they die. Global 
warning is a very important issue for the survival of life on earth. 

Find 
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 A Find and Replace dialog box appears. 

 To just Find the word, click Find. Enter text you want to search in the 

Find what box. To find one such word, or phrase, click Find Next. To find 

all occurrences of the word or phrase, click Find in , then click Main 

Document. 

 To find and replace, click Replace tab. Enter text to find in Find what. 

Enter text to replace in Replace with. 

 Choose the action to be taken by clicking on – Replace, Replace All, Find 

Next, buttons accordingly. 

 

 

 

 

 

 

 

 

 

 

Note: 

You need to be careful while using Replace All. Replace All is a global function. 

It replaces the selected text with the specified text all over the document. 

There may be an instance where a word needs to be retained, but in a global 

replace, it gets over written. For example if in the text you had typed, there 

was a sentence “We must pay heed to the warning signals of nature.”, and you 

used a global replace (Replace All), the word warning would also be replaced as 

warming! 

EXERCISE 

 

Perform the following activities till you are confident: 

 

S.No. Activity 

1. Replace text in a document using Find option   

 

 

 

 

What is Global Warming?  

Global warming is when the earth heats up (the temperature 
rises).  Global warming happens when greenhouse gases (carbon 
dioxide, water vapor, nitrous oxide, and methane) trap heat and light 
from the sun in the earth‟s atmosphere, which increases the 
temperature.  This hurts many people, animals, and plants.  Many 
cannot take the change, so they die. Global warming is a very 
important issue for the survival of life on earth. 



31 

 

SESSION 9: CREATE LIST OF ITEMS  USING BULLETS AND NUMBERING 

RELEVANT KNOWLEDGE 

Very often, you need to create a list of items. This can be neatly done by using 

the features described below:  

You need to create a document as given below in the box. 

 

 

 

 

 

 

 

 

 

 

 

 

Enter the above text in the document. Now do the following steps: 

1. Select the text of the group of first four statements below the heading 

“Greeting a friend”. 
2. On the Home tab, in the Paragraph group, click the Bullets icon. You will 

see that the bullets appear at the beginning of each of the four 

sentences. 

3. Repeat this process by clicking on the down arrow next to the Bullets 

icon. You can select a bullet shape from here. 

Repeat the above given step 1 and 2 with the other two headings. 

 

Every interaction starts with some form of greeting. Given below are some 

statements we generally make whenever we greet someone. 

 

Greeting a friend: 

 Hi! How are you doing? 
 Hey! It has been a long time since we last met! 
 Hi! What are you doing now? 
 Hey! How‟s life? 

 

Greeting an acquaintance: 

 Hello! How are you? 
 Hello! How have you been? 
 Good morning/afternoon/evening! All‟s well? 

 

Greeting a stranger:  

 Hello!  
 Good morning/afternoon/evening! 
 How do you do? 
 My name is Aarti. May I know your name? 
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Now create another document and create a bulleted list of items you would 

pack, when you for a family holiday. Try numbering this list, with the 

Numbering icon. 

 

 

 

 

When is it better to use bullets than numbers? 

Use numbered lists when you're working with instructions to be done in a 

sequence i.e. steps to be followed, and the numbers suggest a hierarchy. The 

same applies when you refer to specific items by number. Numbered and 

unnumbered lists are more commonly used in scholarly publications. If numbers 

aren't essential (very necessary), use bullets, especially in business documents. 

When to capitalize the first letter in a bulleted item? 

In most cases, it is recommended that you start each bulleted item with a 

capital letter. Till now, you have capitalized only proper nouns and the first 

word of a complete sentence, so it almost seems wrong to capitalize single 

words and phrases. However, for the sake of a good presentation, you need to 

do it anyway. 

EXERCISE 

 

Perform the following activities till you are confident: 

 

S.No. Activity 

1. Create a bulleted list of the items in a document 

2. Create a numbered list of the items in a document 

 

  

Bullets Numbering  

Figure 12 
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SESSION 10: FORMAT FONT STYLE 

RELEVANT KNOWLEDGE 

We have learned some of the formatting options available in word processors, 

in some of the previous exercises. In this exercise you will learn to change the 

font style of the selected text in a document.  

Font refers to the style of writing i.e. how the characters look in the document. 

The look of characters can be changed using the Font face (name), Font Size, 

and Font Color. 

Create the document shown below.  

 

 

 

 

 

 

 

 

 

In this exercise, you will learn to change the font in two ways; using the icons 

on the Ribbon and using the shortcut menu. 

 

I.  Using the Icons on the Ribbon 

Select the text “This is Cambria font.” 

Now on the Home tab, left click on the small 

arrow. A screen displaying a list of Font types 

appears. 

Click on the Cambria font. The font of the 

selected text will change to Cambria.  

 

 

 

 

 

 
This is Cambria font. 
This is Times New Roman font. 
This is Bookman Old Style font. 
This is Courier New font. 
This is Book Antiqua font. 
This is Algerian font. 

 

Figure 13: Font Selection 

Figure 14: Font 
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Now go ahead and follow the same steps for changing the font style of others 

sentences, to what is written in the text.  

 

 

 

 

 

 

 

 

 

 

 

II.   Using Short cut menu and the dialog box 

We will restart with the original document above. 

Select the text “This is Cambria font” and right click the mouse button. A Short 

cut menu appears. 

 

 

 

 

 

 

 

 

 

Figure 17: Short Cut Menu 

This is Cambria font. 

This is Times New Roman font. 
This is Bookman Old Style font. 
This is Courier New font. 
This is Book Antiqua font. 
This is Algerian font. 

Figure 15: Font changed in line-1 

This is Cambria font. 

This is Times New Roman font. 
This is Bookman Old Style font. 
This is Courier New font. 

This is Book Antiqua font. 

This is Algerian font. 

Figure 16: Different fonts 



35 

 

 

Click on the option Font…. A Dialogue box appears with the Font tab selected 

by default. 

Choose the font Cambria from the given font list. If needed use the scroll bar. 

Now go ahead and follow the same steps for changing the font style of others 

sentences, to what is written in the text.  

 

 

 

 

 

 

 

 

 

 

Create the document as shown in left side of the figure 19. Then change the 

font size of each of the sentences, as shown in the right side of Figure 19. 

o The steps to do this are similar to what you followed for changing the 

font style. 

o The only difference is that now you need to use the option of changing 

the font size, instead of the font style. 

 

 

 

 

 

 

 

Figure 18: Dialogue Box for changing Font 

This is font size 8. 
This is font size 9. 
This is font size 10. 
This is font size 11. 
This is font size 12. 
This is font size 13. 
This is font size 14. 
 
 

This is font size 8. 
This is font size 9. 
This is font size 10. 
This is font size 11. 
This is font size 12. 
This is font size 13. 
This is font size 14. 
 
 

Figure 19 



36 

 

EXERCISE 

 

Perform the following activities till you are confident: 

 

S.No. Activity 

1. Change the Font style of text using the ribbon 

2. Change the Font style of text using a short cut menu 

3.  Change the Font size of text using the ribbon 

4. Change the Font size of text using a short cut menu 

Additional Practice Exercise: 

Create a new document on any topic. Now change both the font style and font 

size of the contents of different parts of this document. 
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SESSION 11: ALIGNING THE TEXT  

RELEVANT KNOWLEDGE 

Now that we have seen some different capabilities of a word processor, let us 

see how this can be useful. A common usage or example of a document is a 

letter. We can use a Word Processor to type a letter in the proper form. You 

need to write the following letter in a document. 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tagore Public School  
Ambala Cantt 

5th January 2012 

M/s New Star Sports Company 
Kalkaji 
New Delhi -1100 

Sub: Order for Sports Materials. 
Dear Sir, 

 

Kindly send the following Sports material at the above address through 

transport with proper cash bill. 

1. Foot Ball (10 Nos). 

2. Cricket Balls. (20 Nos). 

3. Tennis Balls (20 Nos). 

4. Cricket Bats (10 Nos). 

All the items should be in good condition and packed properly. Any damage 

to these items during transportation will be your responsibility. The items 

should reach the school within 10 days after the receipt of the letter; 

otherwise the order shall stand cancelled. 

Thanking you 

Yours sincerely 

Nitish 

(Head Boy) 
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 Now save the above document in the computer. 

 The date in the above letter is on the right hand side. This is called Right 

Alignment of a text. 

 Similarly, the subject line in the above letter is in the middle. This is called 

Centre Alignment of the text. 

 

 

 

o On the Home Tab you would notice the set of icons 

o To Right Align the date, select the date. Then click the icon for Align 

Text Right. Similarly, you can Centre Align the Subject line in the above 

letter. 

o Do remember to save the above letter. 

EXERCISE 

 

Perform the following activities till you are confident: 

 

S.No. Activity 

1. Align text to the left 

2. Align text to the centre 

3.  Align text to the right 

4. Align text to both left and right margins 

 

 

 

 

 

 

 

  

 

 

 

Figure 20: Align Text 
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SESSION 12: VIEWS OF A DOCUMENT 

RELEVANT KNOWLEDGE 

Word Processors provide options to work on a document in different 

formats/layouts – Print Layout, Full Screen Layout, Web Layout, Outline and 

Draft. 

Each of these layouts gives a different look to the document. You can use a 

particular view depending on what you want to do with the document. For 

example, if you want to print a document, use Print Layout view. If you want to 

create a web page, use Web Layout view. 

Open a new document and write the following text. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click on the View tab, on the Ribbon. The icons in the Document Views group 

are as shown in Figure 21. 

 

 

 

Leadership Qualities 

Leadership can be defined as one's ability to get others to willingly follow. 
Every organization needs leaders at every level. Leaders can be found and 
nurtured if you look for the following character traits. 

A leader with vision has a clear, vivid picture of where to go, as well as a 
firm grasp on what success looks like and how to achieve it. But it's not 
enough to have a vision; leaders must also share it and act upon it. Jack 
Welch, former chairman and CEO of General Electric Co., said, "Good business 
leaders create a vision, articulate the vision, passionately own the vision and 
relentlessly drive it to completion." 

A leader must be able to communicate his or her vision in terms that cause 
followers to buy into it. He or she must communicate clearly and 
passionately, as passion is contagious. 

A good leader must have the discipline to work toward his or her vision single-
mindedly, as well as to direct his or her actions and those of the team toward 
the goal. Action is the mark of a leader. A leader does not suffer "analysis 
paralysis" but is always doing something in pursuit of the vision, inspiring 
others to do the same. 
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The commonly available views are: 

 Print Layout: It is the default document view setting. You will be able to 

see how the document will look when it gets printed. 

 Full Screen Reading: This view 

provides the maximum space 

available for reading the document. 

It hides the ribbon  

 

 

 and provides a full screen view of the document in two (side-by-side) 

frames, similar to a book. This gives more text on the screen and makes 

it easier to read a multi-page document. 

 Web Layout: It shows how the document will appear in a web browser. In 

this view the document looks like a web page. 

 Outline: This view displays the document as an outline and shows only 

the headings present in the document. This enables you to see the 

structure of the document and move to different parts of your document 

easily. This view is useful when you are looking at a document which has 

large number of pages and sections. 

 Draft: This view is used for quick editing of the document. You would 

normally not use this view. It is helpful for proof reading of the 

document. 

Click on the icons for different layouts and see how the different view looks 

like. Look for differences between different views. In each of the views, a 

toolbar opens with tools for editing of the document depending on the view. 

When you have been through all the Views, save and close the document. 

Note: You can't set a default for all documents that you view in Word, because 

the view setting is stored with each individual document as a document 

property. You can save your document in the view with which you want it to 

open. Documents that you receive from others will open with the view in which 

they were previously saved. 

 

 

 

 

Figure 21: Document Views 



41 

 

EXERCISE 

 

Perform the following activities till you are confident: 

 

S.No. Activity 

1. View the document as it will appear on the Printed Page 

2. View the document in Full Screen 

3.  View the document as it will look as Web Page 

4. View the document as Outline 

5. View the document as Draft 
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SESSION 13: RINT A DOCUMENT 

RELEVANT KNOWLEDGE 

 

A copy of a saved document is accessible on the computer using the word 

Processor. However, after is completed, it needs to be printed to be read by 

others who are not using a computer. 

Good to Know: In IT jargon, a document saved on the computer is called a Soft 

Copy and one that is printed is called Hard Copy. 

Open a new document and write the following text. 

 

 

 

 

 

 

 

 

 

You will now take a print out of this document. Make sure that there is a 

printer connected with your computer and has paper in it. Do the following: 

 Click [1] File  [2] Print. A Print dialog box appears. There are many 

settings available in this dialog box, which you can use, as required. Make 

settings as per the following: 

 

o Print Range: You can select what you want to print: 

 All: Whole document 

 Current Page: Page on which the cursor is currently placed. 

 Selection: Only the selected text is printed. 

 Pages: Specify the selected page numbers that need to be printed. For 

example, 2-6 means, print page numbers 2, 3, 4, 5 and 6 while1,3 means, 

print page numbers 1 and 3. 

o Copies: You can select the number of copies of the document to be printed. 

Integrity is the integration of outward actions and inner values. A person of 
integrity is the same on the outside and on the inside. Such an individual 
can be trusted because he or she never veers from inner values, even when 
it might be expeditious to do so. A leader must have the trust of followers 
and therefore must display integrity. 

Honest dealings, predictable reactions, well-controlled emotions, and an 
absence of tantrums and harsh outbursts are all signs of integrity. A leader 
who is centred in integrity will be more approachable by followers. 

Dedication means spending whatever time or energy is necessary to 
accomplish the task at hand. A leader inspires dedication by example, doing 
whatever it takes to complete the next step toward the vision. By setting an 
excellent example, leaders can show followers that there are no nine-to-five 

jobs on the team, only opportunities to achieve something great. 
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o Properties: If you click on the Properties, a dialog box appears (Figure 22), 

with many more options which can be set. We will not discuss them right 

now. You will learn about them later (in advanced levels). 

 

 

 

 

 

 

 

 

 

 

 Click OK to print the document. 

EXERCISE 

 

Perform the following activities till you are confident: 

 

S.No. Activity 

1. Print the whole document 

2. Print current page 

3.  Print selected text 

4. Print selected pages 

 

  

Figure 22: Print Dialog Box 
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SESSION 14: CREATE A TABLE 

RELEVANT KNOWLEDGE 

Like a list, information often needs to be presented in a tabulated, organized 

manner. You will learn to present tabulated information in this exercise. 

A table is an arrangement of rows and columns, as shown in Figure 23. 

 

 

 Name Age Height (cm) 

1. Ajay Mohan Goel 13 150 

2. Mehul Kapoor 14 155 

3. Parampreet 

Ghuman 

13 145 

4. Thomas Matthews 15 154 

5. Ashfaq Ali 14 152 

6. Venkat Subrmaniam 13 143 

7. Vijay Mandke 14 157 

8. Mary Kom 15 149 

 

A table helps you to present information in an 

organised form. Each of the rows given in the 

above able may also be called a Record. Now 

you need to create the above table, which has 

4 columns and 9 rows. 

 Click on your document where you want 

to create a table. 

 

 Select the Insert tab. Select Table from 

the Tables group. An Insert Table drop 

down menu appears 

 Take your mouse pointer to the first 

left-hand upper-corner empty box in 

this menu A single column, single row 

table appears on your document (at the 

position where you had last left your 

cursor). Keeping the left button pressed 

Columns 

Rows 

Cell 

Figure 23: A Table and its components 

Figure 24: Insert a Table 
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drag and select four boxes for 4 columns and a few boxes for rows. (You 

can see the table being created on your document.)  

 

 To complete the process click the left button of the mouse. 

 

 An empty table having the selected number of rows and columns is 

inserted in the document. Enter the data (refer sample above) in the 

table by clicking on each cell. 

Note: You can move from cell to cell row-wise using the Tab key. When you 

reach the last cell (right hand bottom corner) of a table, and you press Tab 

key once again, a fresh row is added at the bottom. 

EXERCISE 

 

Perform the following activities till you are confident: 

 

S.No. Activity 

1. Insert table in a document with specified rows and columns 

2.  Insert rows to a table 

Additional Practice Exercises: 

a) Create a table in which you list down all the books in your school bag. 

You can have serial number, name of the book, subject name, no. of 

pages in the book etc. 

 

b) Create a table in which you list down; name, address, phone number of 

ten of your friends or relatives. 
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SESSION 15: FORMAT A TABLE 

RELEVANT KNOWLEDGE 

By formatting a table, you can improve the appearance of a table and make it 

more presentable and attractive. 

Create a table with the following headers: Serial Number (S.No.), Teacher‟s 
Name and Subject (the subject taught by the teacher). A sample is given 

below: 

 

 

 

 

 

1.  Formatting the table 

1. Click anywhere on the table which you have created. A Design tab and a 

Layout tab appear in the ribbon, as shown in the figure below. 

2. Click on the Design tab. 

3. Experiment with the different styles given in the ribbon and the various 

options, on the created table. Using some of these options, the above 

table can be formatted in the following manner: 

 

 

 

 

 

 

 

 

You can go ahead and try some more options on the same table and format it in 

different ways. 

S.No. Teacher‟s Name Subject 

1. Ms.Radhika Madan Hindi 

2. Mr.Subramaniam Reddy Maths 

3. Mr. Austin Thomas English 

4. Ms.Sudipta Roy Science 

5. Dr.Pritam Singh Social Studies 

6. Ms.Vibha Goel Computer 

Science 

S.No. Teacher’s Name Subject 

1. Ms.RadhikaMadan Hindi 
2. Mr.Subramaniam Reddy Maths 

3. Mr. Austin Thomas English 
4. Ms.Sudipta Roy Science 
5. Dr.Pritam Singh Social Studies 

6. Ms.Vibha Goel Computer 
Science 

Figure 25: Format a Table 
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2.  Layout of the Table 

More settings are available under the Layout tab as shown in Figure 26. Click 

on the Layout tab to view them. You can go ahead and click on different 

icons to experiment with varying ways of changing the layout of the table. 

 

 

Some of the tasks you can do are as follows: 

 

 Add one more teacher for the third language. Do this by keeping the 

cursor on the last row of the table and clicking on the icon for Insert 

Below. This inserts a blank row below the current row, where the cursor 

is positioned. 

 Add one more column to this table. Position the cursor anywhere on the 

last column. Click on the icon Insert Right. This inserts a column on the 

right hand side. In this column you can add the educational qualifications 

of the teacher. 

 Now add one more row on top of the table. Merge all the cells in the new 

row added by using the icon Merge Cells. Note: Before clicking on this 

icon, you should select all the cells in the first row. 

 

 

 

 

 

 

List of Teachers in Standard IX-A 

S.No. Teacher’s Name Subject Qualifications 

1. Ms.Radhika Madan Hindi MA, B.Ed 
2. Mr.Subramaniam Reddy Maths M.Sc., B.Ed. 

3. Mr. Austin Thomas English MA, M.Phil. 
4. Ms.Sudipta Roy Science M.Sc., B.Ed. 

5. Dr.Pritam Singh Social Studies MA, Phd 
6. Ms.Vibha Goel Computer Science BCA, B.Ed 
7. Mr.Sharanjit Singh Sanskrit MA, B.Ed 

Figure 26: Table layout icons 
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EXERCISE 

 

Perform the following activities till you are confident: 

 

S.No. Activity 

1. Change the design of a table 

2.  Add rows to a table 

3. Add columns to a table 
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SESSION 16: CONVERT TEXT TO TABLE AND TABLE TO TEXT 

RELEVANT KNOWLEDGE 

In most of the word processors, there is a feature to convert a normal text data 

into a table. In this exercise you will convert the text data into a table. Create 

a document with the following details: 

 

 

 

 

 

 

 

Note: Commas have been inserted between the different data. This indicates 

where you want to divide the text into columns. Use paragraph marks (Press 

Enter key) to indicate where you want to begin a new row.  

 Select the text that you want to convert from the document. 

 On the Insert tab, in the Tables group, click Table, and then click Convert 

Text to Table. This is shown in below. 

 A Convert Text to Table dialog box appears as shown in Figure 27.. 

 In the Convert Text to Table dialog box, under 

Separate text at, click the option for the 

separator character that is in your text (Commas 

in this case). 

 In the Number of columns box, check the 

number of columns. If you don't see the number 

of columns that you expect, you may be missing 

a separator character in one or more lines of 

text. 

 Select any other options that you want. 

 

 

 

 

 
Ajay, 991049644, Delhi, Delhi 

Anita, 9891262366, Noida, UP 

Sudha, 8089942315, Hissar, Haryana 

Gautam Sen, 7467698234, Guwahati, Assam 

Rajshekhar, 9234987492, Coimbatore, Tamil Nadu 

 

Figure 27: Text to Table 
Conversion  
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The table created will look like the following: 

Ajay 991049644 Delhi Delhi 

Anita 9891262366 Noida UP 

Sudha 8089942315 Hissar Haryana 

Gautam Sen 7467698234 Guwahati Assam 

Rajshekhar 9234987492 Coimbatore Tamil Nadu 

You can also convert the table to text. 

Select the entire 

table. You can do 

this by dragging 

your cursor over 

the table, or by 

going again to the 

menu bar, clicking 

on "Table" and then 

scroll down to 

"select table". Once you have selected the 

entire table, go again the "Table" menu and 

scroll down to "convert table to text". You will 

get another formatting dialog box, this time 

asking how you wish to separate the values. 

"Tab" is selected by default, so just click "OK". 

Your table will be converted into a tabbed 

format, nicely and evenly spaced. 

Figure 1 : Dialogue Box 
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You may choose the option Tabs and here you go. Your table will get converted 

to text. 

EXERCISE 

a)  

Perform the following activities till you are confident: 

 

S.No. Activity 

1. Convert text to table 

2.  Convert table to text 

Additional Practice Exercises: 

Create a notice from the Headmistress informing all your class mates about the 

details of the school picnic planned for the next weekend. The notice should 

inform the date, departure and return time, place of departure, fees to be 

paid, place to be visited, a picture of the place. The notice can also have a few 

instructions for the students. For example, students who are not attending the 

picnic to stay back at home / students attending to wear I-Cards etc. You must 

use the following features of word processing, while creating the notice: 

 Table 

 Bold and underline 

 Check the Spellings and Grammar 

 Save the document 

Now convert the table into text. 
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SESSION 17: ADD BORDERS TO PAGES, PARAGRAPHS AND TEXT 

RELEVANT KNOWLEDGE 

A border around text highlights the information and makes it look better. Word 

processors enable you to do that neatly for the entire document or part of it. 

Part-1: Add borders to a Page 

Follow the steps given below to add a border to the complete page: 

 Open a new document.  

 On the Page Layout tab in the Page Background group, click Page 

Borders. A Borders and Shading dialog box appears. 

 In the Borders and Shading dialog box, do one of the following: 

o To add a paragraph or text border, click the Borders tab. 

o To add a page border, click the Page Border tab. This tab has 

three sections. 

 In the left most section, Under Setting, select the type of border you 

want. 

 In the center section, you can modify the line style, border color, and 

width. You can even click Art to add a design to a page border. 

 

  

 

 

 

 

 

 

 

 

 

 

 Check Preview to see how the border will look. Click the buttons to add 

or remove borders along the sides, top, and bottom. 

Figure 29: Borders and Shading 
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 Select the down arrow of Apply to, and select the parts of the document 

that you want the border to enclose, such as Text, Paragraph, or 

Section. Then, click OK. 

2.  Add borders to a paragraph or a text 

Type the following paragraph in a document. 

Assertiveness is not the same as aggressiveness. Rather, it is the ability to 

clearly state what one expects so that there will be no misunderstandings. A 

leader must be assertive to get the desired results. Along with assertiveness 

comes the responsibility to clearly understand what followers expect from 

their leader. 

Many leaders have difficulty striking the right amount of assertiveness, 

according to a study in the February 2007 issue of the Journal of Personality 

and Social Psychology, published by the APA (American Psychological 

Association). It seems that being under assertive or overassertive may be the 

most common weakness among aspiring leaders. 

 Now select the text which you have typed. 

 Follow exactly the same steps as specified for bordering a page, with only 

one difference. Choose the tab Borders in the Borders and Shading dialogue 

box. 

Assertiveness is not the same as aggressiveness. Rather, it is the ability to 

clearly state what one expects so that there will be no misunderstandings. A 

leader must be assertive to get the desired results. Along with assertiveness 

comes the responsibility to clearly understand what followers expect from 

their leader. 

Many leaders have difficulty striking the right amount of assertiveness, 

according to a study in the February 2007 issue of the Journal of Personality 

and Social Psychology, published by the APA (American Psychological 

Association). It seems that being under assertive or overassertive may be the 

most common weakness among aspiring leaders. 

You can similarly create a border around a group of words, by selecting that 

group of words, and following the same steps as given above. An example is 

given below. 

A sense of humor is vital to relieve tension and boredom, as well as to defuse 

hostility. Effective leaders know how to use humor to energize followers. 

Humor is a form of power that provides some control over the work 

environment. And simply put, humor fosters good camaraderie. 
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EXERCISE 

a)  

Perform the following activities till you are confident: 

 

S.No. Activity 

1. Add borders to a page 

2.  Add borders to a paragraph or text 
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SESSION 18: ADD SHADINGS TO PAGES, PARAGRAPHS AND TEXT 

RELEVANT KNOWLEDGE 

Similar to borders, shading highlights desired parts of the text. The steps to 
apply shading are almost the same as that for applying borders as given in 
figure 30.  

 On the Page Layout tab in the Page Background group, click Page Borders. A 

Borders and Shading dialog box appears. 

 Click on the tab Shading as 

shown in Figure 30 

 

 
 

 

 

 

 

There are three options in this box. 

o Fill: By clicking on the down arrow on the Fill option, a colour palette is 

displayed. You can choose, which colour shading is to be used. 

o Style: This option allows the changes in darkness of the shading and also 

different patterns of shading.  

o Apply to:By clicking on the down arrow on this option, you can choose if you 

want to shade only the selected text or the entire paragraph. 

Two sample shadings are shown below as examples. 

Assertiveness is not the same as aggressiveness. Rather, it is the ability to 

clearly state what one expects so that there will be no misunderstandings. A 

leader must be assertive to get the desired results. Along with assertiveness 

comes the responsibility to clearly understand what followers expect from 

their leader. 

 

Assertiveness is not the same as aggressiveness. Rather, it is the ability to 

clearly state what one expects so that there will be no misunderstandings. A 

Figure 30: Shading dialogue box 
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leader must be assertive to get the desired results. Along with assertiveness 

comes the responsibility to clearly understand what followers expect from 

their leader. 

 

EXERCISE 

a)  

Perform the following activities till you are confident: 

 

S.No. Activity 

1. Apply a shade to a paragraph 
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SESSION 19:  PREVIEW A DOCUMENT, ADJUST ITS MARGINS AND 

ORIENTATION 

RELEVANT KNOWLEDGE 

After the document is typed and formatted, the last step is to adjust it so that 

it prints in the desired manner on paper. 

1. Margins 

Page margins are the blank space around the edges of the page. You can 

position some items in the margins such as headers, footers page numbers etc. 

A document has top, bottom, left and right margins. In a document there are 

default settings of the margins. You can change the margins in a document. 

Typical process to adjust / change margins is as follows: 

1. Select the Page layout tab, as shown in Figure 31. 

 

2. Click on Margins in the Page Setup group. A Margins drop down list 

appears. 

 

3. You can select any one of the options shown, Narrow, Moderate, Wide or 

Mirrored. In case you want to customise and specify each of these 

margins, then click on the Customised Margins… option. A Page Setup 

dialogue box appears. You can individually adjust any of the margins. 

 

 

 

 

 

 

 

 

 

Figure 31: Page Layout tab 
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Open a saved document (from one of your previous exercises), change the 

margins in it and see how the display changes on the screen. You can also do a 

Print Preview of the document, to see how it would be printed. Print Preview 

will be explained later in this exercise. 

2.  Orientation 

Normally, when you open document will be in “Portrait 
Orientation.” Portrait means that the page is taller than it is 

wider. Portrait works for most documents, but sometimes 

you might want to put that page on its side or landscape, 

which is when the page is wider than it is taller. 

 To change the page orientation, click on the Page 

Layout tab on the Ribbon, and then click on the 

Orientation button.  This will give you your two 

options, portrait or landscape. 

Figure 34: Page 
Orientation 

Figure 32: Setting Margins 

Figure 33: Page Setup 
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 To change to Landscape orientation, click on the Landscape icon. 

 Observe the effect of changing the orientation to Landscape as compared 

to Portrait. 

 

3.  Print Preview 

Print Preview enables you to see what the document will look like when it is 

printed. You can Print Preview a document by selecting [1] File  [2] Print  

[3] Print Preview. A Print Preview tab opens. Based on how you want the final 

printout to look, you can adjust the Margins, Orientation etc. A sample Print 

Preview of a page (Figure 35). 

 

 

 

 

 

 

 

 

 

EXERCISE 

 

Perform the following activities till you are confident: 

 

S.No. Activity 

1. Set margins for a printable document 

2. Change the page orientation to portrait or landscape 

3.  Preview a document before printing 

 

 

Figure 35: Print Preview 
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SESSION 20: ALIGN TEXT USING TABS 

RELEVANT KNOWLEDGE 

Tabs are often used to format documents. To understand the concept of tabs, 

look at the text below. 

 Left Aligned Centre Aligned Right Aligned 

 Sanjay Kapoor Male Blue 

 SenhlataPremKumari Female Red 

 MehulMandke Male Violet 

 P R Subramanian Male Orange 

 

 A Left Tab stop sets the start position of text that will then run to the right 

as you type. 

 A Centre Tab Stop sets the position of the middle of the text. The text 

centers on this position as you type. 

 A Right Tab Stop sets the right end of the text. As you type the text moves 

left. 

You can observe this by seeing how the tabs were set in the above table, by 

looking at the type of tab and its position on the ruler bar.  

Note: If you do not see the horizontal ruler that runs along the top of the 

document, click the View Ruler button  at the top of the vertical scroll bar. 

 

 

  

] 

 

 

 

 

To set Tabs, do the following: 

1. Click the tab selector at the left end of the ruler until it displays the 

type of tab that you want and then clicking the ruler at the location you 

want. The tab selector is shown in Figure 37. 

Left Tab Center Tab Right Tab 

Figure 36: Type of tabs and their position 
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Use the tabs to create the text which was displayed above in this exercise. 

 
EXERCISE 

a)  

Perform the following activities till you are confident: 

 

S.No. Activity 

1. Set left tab stop in a document 

2. Set centre tab stop in a document 

3.  Set right tab stop in a document 

Additional Practice Exercises: 

Write a letter – to a shop manager – asking for a job. You must use the 

following features of a word processor to write the letter: 

 Bold and Underline some parts of the text. 

 Bullets 

 Change the margins 

 Save the document 

 Take a Print out. 

Create your resume (Bio data). It should have your name, address, email 

address, date of birth, nationality, languages known, where currently 

employed, employment history if any, educational qualifications, 

extracurricular activities you have participated in, awards won etc. 

 

Figure 37: Tab Selector 


